
• This guide explains how to install the software programs and 
briefly introduces their functions and operating procedures. 

You may be able to download images without installing the 
software programs if you use certain operating system 
software (p. 82). (Excludes Windows 2000)

Software Starter Guide
(For the Canon Digital Camera Solution Disk Version 30)

ENGLISH

You must install the software bundled on the Canon 
Digital Camera Solution Disk before connecting the 
camera to the computer.

Install the 
software.

Connect the camera 
to the computer.
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The precautions noted within this guide are intended to instruct you in the safe and correct 
use of the products and to prevent injuries or damage to yourself, other persons and 
property. Please read and ensure that you understand them before proceeding to other 
sections of the guide. 

Trademark Acknowledgments
• Windows, Windows Vista and the Windows Vista logo are trademarks of Microsoft 

Corporation, registered in the U.S. and other countries.
• Macintosh, the Mac logo, Quicktime and the Quicktime logo are trademarks of Apple 

Computer Inc., registered in the U.S. and other countries.

Canon Customer Support
For Canon Customer Support contacts, please see rear of the European Warranty System (EWS) 
Booklet supplied with your camera.

Copyright © 2007 Canon Inc. All rights reserved.

SAFETY PRECAUTIONS

Warnings This symbol indicates topics that could lead to death or serious injury if 
ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data 

CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the 
speakers. It is also possible to suffer from hearing loss from listening with headphones to 
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is 

accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior 
written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, the memory cards, 
personal computers, peripheral devices, or use of non-Canon memory cards.
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Read This First

This chapter explains what you can accomplish using the camera with the software contained 
on the Canon Digital Camera Solution Disk. 
It also lists the computer system configurations required to use the software.

About this Guide
•The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are 

using another version of these operating systems, the actual screen contents and 
procedures may vary slightly from those shown.

•The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.3-v10.4) 
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It’s so Simple! Make Prints Right at Home 
Like a Pro 

See your Camera User Guide for shooting instructions.

Just install the software once at the beginning.

Shoot the images

Install the software on the 
computer

Windows (p. 11)
Macintosh (p. 44)
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Download images to the computer

Print the images

Connect the camera to the computer

Windows (p. 16)
Macintosh (p. 46)

Windows (p. 21)
Macintosh (p. 50)

Precautions for 
Connecting the 
Camera to the 
Computer (p. 10)

See your Camera User Guide for connecting instructions.
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Unbounded Possibilities with Entertaining 
Software 
Print a Variety of Layouts
Print with the diverse layouts available in ZoomBrowser EX (Windows) and ImageBrowser 
(Macintosh). The examples shown are from ZoomBrowser EX (Windows).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch. 

Confirm all your images in one glance 
with index (contact sheet) printing.

With One Photo per Page Print, 
printing images is also easy.



Read This First 7
W

indows/M
acintosh

Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from within 
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer (Remote Shooting)
You can use ZoomBrowser EX  (Windows) or ImageBrowser (Macintosh) to operate the camera 
shutter from the computer to shoot images (Remote Shooting). The recorded images are 
downloaded directly to the computer. 

Edit a Movie
You can edit movies, linking movies and stills that have been downloaded to the computer, 
adding text, such as titles, adding background music or applying various special effects. 

Extract Stills from Movies 
You can extract a still from the displayed movie and save it as a new image file. You can also 
specify a range of frames and extract multiple stills.  

The shutter is operated from the computer.
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System Requirements
Please install the software on a computer meeting the following minimum requirements.

Windows

Macintosh

OS Windows 2000 Service Pack 4
Windows XP (including Service Pack 1 and Service Pack 2)
Windows Vista

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU Windows 2000/Windows XP: Pentium 500 MHz or higher
Windows Vista: Pentium 1.3 GHz or higher

RAM Windows 2000/Windows XP: 256 MB or more
Windows Vista: 512 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ZoomBrowser EX: 200 MB or more 
- PhotoStitch: 40 MB or more

•Canon Camera TWAIN Driver: 25 MB or more

Display 1,024 x 768 pixels/High Color (16 bit) or better

OS Mac OS X (v10.3-v10.4)

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU PowerPC G3/G4/G5 or Intel Processor

RAM 256 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ImageBrowser: 200 MB or more 
- PhotoStitch: 40 MB or more

Display 1,024 x 768 pixels/32,000 Colors or better
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Programs and Compatible Operating Systems
The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It 
contains the following programs.

Windows Programs

*1 Can be started from within ZoomBrowser EX.
*2 Installation of the driver is not required.
*3 Images are downloaded using ZoomBrowser EX.

Macintosh Programs

*1 Can be started from within ImageBrowser. 

•A CD-ROM drive is required to install the software.   
•Even when system requirements are met, not all computer functions can be 

guaranteed. 
•A sound card is required to play movie file audio tracks under Windows.
•With Windows, QuickTime is required to save images merged with 

PhotoStitch as QuickTime VR images. It is also required to play and edit 
movies on the Windows 2000 platform.

•Macintosh software cannot be used on disks formatted in the UFS (Unix File 
System) format.

Compatible OS Windows
 2000 

Windows
 XP*2 

Windows
 Vista*2 Major Functions

Program

ZoomBrowser EX 
Downloading, displaying, 
organizing and editing 
images 

TWAIN Driver Driver for Canon brand 
cameras (Windows 2000)

PhotoStitch*1 Merging images to make 
panoramas 

EOS Utility   *3
Downloading images and 
other functions for EOS 
DIGITAL series cameras

Compatible OS
Mac OS X Major Functions

Program

ImageBrowser Downloading, displaying, organizing and 
editing images 

PhotoStitch*1 Merging images to make panoramas 

EOS Utility Downloading images and other functions 
for EOS DIGITAL series cameras
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Before You Connect the Camera to the Computer

Precautions for Connecting the Camera to the Computer
•The connection may not operate correctly if you attach the camera to the computer with an 

interface cable via a USB hub.
•The connection may not operate correctly if you are using other USB devices, excluding USB 

mice or keyboards, at the same time as the camera. If this occurs, disconnect the other 
devices from the computer and try reconnecting the camera.

•Do not connect two or more cameras at the same time to the same computer. The 
connections may not operate correctly.

•Never allow the computer to go into standby (sleep) mode while a camera is connected via 
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken 
the computer with the camera in the connected state. Some computers will not awaken 
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to 
your computer manual for instructions regarding the standby (sleep) mode.

Ensure that you have installed the software from the supplied Canon Digital 
Camera Solution Disk before you connect the camera to the computer. 

•You are recommended to power the camera from a household power source 
(AC adapter) when connecting to a computer. Ensure that you use fully 
charged batteries if you will not be using a household power source. 

•See the Camera User Guide for procedures connecting the camera to the 
computer.
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Using the Software on the Windows 
Platform – Preparations

This chapter explains the basic procedures for installing the software and connecting the 
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare
•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Confirm that the camera is NOT connected to 

the computer. 
If it is, disconnect the cable. The software cannot 
be properly installed if the camera is connected to 
the computer at the start.

2 Close any programs that are running. 

•You must install the software before you connect the camera to the 
computer. 

•You must have authorization as a Computer System Administrator to install 
programs. 
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3 Place the Canon Digital Camera Solution Disk in the 
computer’s CD-ROM drive.
If the [User Account Control] window appears, follow the 
on-screen instructions to proceed.
If the installer panel does not appear automatically, use the 
following procedures. 

4 Click the Digital Camera Software [Easy 
Installation] button.
To individually select the software to install, 
click [Custom Installation]. 

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear 
automatically.

Windows Vista
1. Select [Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [SETUP.EXE]*  icon.
4. When [User Account Control] window displays, follow the on-screen instructions to 

proceed.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [SETUP.EXE]*  icon.

Windows 2000
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [SETUP.EXE]*  icon. 

* Some computers may not display the [.EXE] file name extension as shown above.

Installer Panel
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5 If other software is running, close each 
program before clicking [OK].

6 Review the installation settings and 
click [Install].

The items displayed here differ according to 
the software installed.

7 Click [Yes] if you agree to all of the 
terms of the software license 
agreement. 

The installation will start.

Follow the on-screen instructions to 
proceed with the installation.

When [Custom Installation] is Selected with Windows 2000
The USB driver (the software for connecting) is required when the camera 
is connected to the computer with an interface cable. Ensure that you 
select the USB driver [Canon Camera TWAIN Driver]. 

*With Windows Vista and Windows XP, the USB driver supplied with the 
Windows operating system is used so there is no need to install a USB 
driver.
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8 When the installation is over, select 
[Restart computer immediately 
(Recommended)] and click [Restart].

At this stage, do NOT remove the Solution 
Disk from the CD-ROM drive yet.

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish], 
remove the Solution Disk from the CD-ROM drive and proceed to Step 10.

9 Remove the disk from the CD-ROM drive when your 
normal desktop screen appears after restarting.
This concludes the software installation. 
Continue by connecting the camera to the computer so 
that the USB driver can be utilized. 

10 Attach the camera to the computer with the 
interface cable and set the camera to the 
correct mode for connecting.

If you installed a USB driver, so far the required files have only been 
copied to your computer. You must now connect the camera to the 
computer with the interface cable to complete the installation and 
prepare the driver for use. 

See Uninstalling the Software (p. 72) to delete the installed programs.

Procedures for attaching the camera to the computer and placing the 
camera in the correct mode for connecting vary between camera models. 
See the Camera User Guide. 
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If the Digital Signature Not Found window 
appears, click [Yes].

The USB driver will automatically finish installing onto the computer when you attach the 
camera and open a connection. 
Dialogs similar to the following will appear during this process (first time the camera is 
connected to a computer only).

Windows Vista 
A message indicating the USB driver installation completion will be displayed.

Windows XP 
The dialog on the right will appear after a 
few moments.

Windows 2000
Restart the computer according to the instructions if you are prompted to do so by a 
message.

A dialog allowing you to set the default settings will display after installation. See Using 
the Software on the Windows Platform – The Basics (p. 16) for the subsequent 
procedures.

This concludes the software and USB driver installation and the procedures for connecting the 
camera to the computer.
You may now download camera images to the computer (p. 16). 

• If you experience problems installing the USB Driver, first uninstall it  
(p. 77) and then reinstall it. (Windows 2000)

•See Uninstalling the USB Driver (p. 73) to delete the USB driver installed 
with these procedures. (Windows 2000)

•See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 81) if you 
were previously using either version. 
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Using the Software on the Windows 
Platform – The Basics

This chapter explains the procedures for using ZoomBrowser EX to download the camera's 
images to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the Windows 
Platform – Preparations section. 

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly 
different according to whether you are using a camera to computer connection (see below) or 
a memory card reader (p. 19). 

Camera to Computer Connection
1 Attach the supplied interface cable to the computer’s USB port and the camera’s 

DIGITAL Terminal. Prepare the camera for communication with the computer.

The Camera Control Window will appear.

Camera Control Window

You may not be able to download images when the camera is connected to a 
computer if there are a large number of images (approximately 1000) on the 
memory card. Use a memory card reader to download in that case.

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See the 
Camera User Guide. 
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2 Download the images.
Download the images using the camera or 
the computer.
By default, the downloaded images are 
saved into the [Pictures] or [My Pictures] 
folder.

Placing a check mark here causes this 
window to automatically open when the 
camera and computer are connected.

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences].

First Time Camera is Connected to a Computer
Set the following settings the first time you connect the camera to the computer. These 
procedures are not required from the second connection onward.

Select [Canon CameraWindow] when a 
dialog (Events dialog) similar to that on 
the right displays and click [OK].

Your camera model name or [Canon 
Camera] will appear here.

Different programs may display 
according to your computer setup.

If this Events dialog does not appear, click the [Start] menu and select 
[All Programs] or [Programs], followed by [Canon Utilities], 
[CameraWindow], [PowerShot - IXY - IXUS - DV 6] and 
[CameraWindow].
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Using the Camera to Download Images (Direct Transfer Function)

 
Set the Direct Transfer settings on the 
camera and press the  (Print/Share) 
button or the FUNC./SET button.

Using the Computer to Download Images
Click [Starts to download images].

• If the conditions are right for the Direct Transfer function, the Direct 
Transfer settings menu will appear in the LCD monitor. In addition, the  

 (Print/Share) button will light if your camera is equipped with one. 
•See the Camera User Guide for instructions regarding Direct Transfer 

settings and procedures. 

•By default, all the images that have yet to be downloaded will download 
to the [Pictures] or [My Pictures] folder.

•To download images that have had their transfer settings set with the 
camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded.

•Click [Lets you select and download images] to show the camera images 
in a list, check the images before downloading and download only 
selected images. 
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The downloaded images are saved into 
folders according to the shooting date.

At the same time, they will also appear 
grouped by date in the [Last Acquired 
Images] at the top of the Folder Area.  

[Last Acquired Images]
The last downloaded images will display according 
to their shooting dates.

Destination for the downloaded images
The downloaded symbol displays on 
downloaded folders.  

Folder area

Thumbnail
According to the default settings, the thumbnails (tiny versions) of the downloaded images 
display in the Main Window when the downloading is complete.

Next, print out the images (p. 21). 

Memory Card Reader Connection
1 Insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2 Select [View/Download Images using 
Canon CameraWindow] when the 
dialog to the right appears and click 
[OK]. 
The Camera Control Window will display.

If the dialog above fails to appear, click the [Start] menu and select [All 
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow], 
[CameraWindowMC] and [CameraWindow], and proceed to Step 3.
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3 Click [Starts to download images].

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences].

The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired Images] at 
the top of the Folder Area. 

Next, print out the images (p. 21). 

•By default, all the images that have yet to be downloaded will 
download to the [Pictures] or [My Pictures] folder.

•To download images that have had their transfer settings set with the 
camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded.

•Click [Lets you select and download images] to show the memory card 
images in a list, check the images before downloading and download 
only selected images.

•See Memory Card Folder Structure (p. 75) for information about 
memory card folder structures and file names.
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Printing Images
There are two ways in which images may be printed: One Photo per Page Print and Index Print. 
This section explains the One Photo per Page Print method. 

One Photo per Page Print
This option prints one image per page in a standard "photo" format. If you select multiple 
images, it will print them on the corresponding number of pages. 

1 Click [Print] in ZoomBrowser EX's Main Window, followed by [One Photo Per Page 
Print].  

•Movies cannot be printed, but with Windows Vista and Windows XP you can 
print stills after they have been extracted from movies and saved to files.

•To use the Index Print option, click [Print] in the Main Window, followed by 
[Index Print].

• If you have installed the Easy-
PhotoPrint program that 
accompanied a Canon-brand 
printer, you will proceed to the 
Easy-PhotoPrint printing window 
shown at the right when you 
select [One Photo per Page Print] 
according to the default settings. 
If a window similar to it opens, 
read the Help menu for Easy-
PhotoPrint for instructions to proceed.

•To proceed to the ZoomBrowser EX printing window as shown in Step 2 
when you select [One Photo per Page Print], click the [Tools] menu and 
select [Preferences], followed by the [Printing] tab. Select [Use the Print 
Function in ZoomBrowser EX]. 
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2 After confirming that [1. Select Images] is selected, select images.
You can select multiple images by holding the [Ctrl] down while clicking on successive 
images.

3 Click [2. Printer and Layout Settings] and adjust the categories as you feel 
necessary. 

4 Click [3. Print].
Printing will start.

The background of 
selected images 
changes to blue.

Selects the printer 
and the paper size 
etc.

Sets the number 
of print copies

This button switches between images if 
multiple images were selected. 

Sets printing to 
"borderless," etc.

Place a check mark 
here to print 
shooting date/time 
information with 
images.
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This chapter explained the ZoomBrowser EX basics. 
Once you have mastered them, try the advanced techniques.
Using the Software on the Windows Platform – Advanced Techniques (p. 24).
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Using the Software on the Windows 
Platform – Advanced Techniques

This chapter explains various ZoomBrowser EX features. 
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the 
Using the Software on the Windows Platform – The Basics chapter.

The ZoomBrowser EX Windows
This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer 
Window and Properties Window.

Main Window
This window is for displaying and organizing images downloaded to the computer.

Folders Area (p. 25)

Task Area (p. 25)

Browser Area (p. 25)

Function Buttons (p. 27)

Switches between showing and hiding 
the Task Area and Folders Area. 

Display Mode 
(p. 26)

Display Control 
Panel (p. 27)
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Task Area 
•ZoomBrowser EX's tasks are arranged here like 

an index.
•Click a Task button to carry out the desired 

task.
These features are described in ZoomBrowser 
EX Features (p. 30).

Folders Area 
•Use this area to select folders. The images in the selected folder display in the Browser Area.

If you select a network drive in advance with Windows Explorer, you can display network 
folders, but you cannot add, change or delete those folders in the Browser Area.

• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will 
display. You are recommended to register a folder that you use frequently as one of the 
Favorite Folders. If you selected All Folders, all the folders will display. 

•Downloaded images also appear in the [Last Acquired Images] area at the top of the Folder 
Area. You can check them in groups sorted by shooting date.

Browser Area
•The images in the folder selected in the Folders Area will display here.

The display style will vary according to your Display Mode selection.
•You can sort the image order in the Browser Area by file name, shooting date or other 

characteristics by selecting [View] and [Sort by].
•The following icons will display around images according to their attributes.

Images shot with the camera's Stitch Assist mode 

RAW images

Movies

Images with sound memo attachments

Protected images

Images shot with the camera's AEB function

Rotated Images (In display only)

Methods for Registering a Favorite Folder
• If [Favorite Folders] is displayed: click [Add] and select a folder. 
• If [All Folders] is displayed: select a folder and click [Add to Favorites].
•To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Using Cameras That Support My Category
• In addition to classifying by Shooting Date, My Category also displays where the [Last 

Acquired Images] message displays after the last image is downloaded.
•Also, in addition to the Star Rating it is possible to sort by My Category using the [Filter 

Tool] function.
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Display Mode
•Selects the display style for the Browser Area.

Zoom Mode
Displays all the images in a folder as thumbnail 
images. This mode is convenient for searching 
for images since many can be displayed at 
once. 

If additional folders are nested within a 
folder, their images are displayed as 
thumbnails as well. 

If you move the mouse cursor over a folder, 
 will display on the upper right. Clicking 

here displays that folder zoomed in. 

Scroll Mode
The images within the selected folder and 
subfolders will display. If you set the display 
folder depth (level) to [1] or greater, the 
thumbnails of the images in the folder will also 
display. You can change the folder depth in the 
[Tools] menu under the [Preferences] option.

Preview Mode
This mode displays the image at a larger size as 
well as the image information. 

Positioning the mouse pointer over a thumbnail causes the image to appear 
at a higher magnification in a Mouse Over Window. You can turn off this 
function by clicking the  [Show Information], and removing the check 
mark from the [Show Mouse Over Windows] option.
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Display Control Panel 
•This panel adjusts the display settings for the Browser Area.

Function Buttons
•These buttons are available for executing various functions.

Selection Menu
Click this to select/deselect all 
images in the Browser Area.  

Show/Hide Image Information Menu
Select here to show/hide such image 
information as the file name or 
shooting date or rating beneath the 
thumbnail. 

Display Size
Changes the size of the 
thumbnail in the Browser Area.

Filter Tool Menu 
Displays only images that 
correspond to the specific 
conditions.

Select Button
Use this to select images 
in Zoom mode.

Fit to Window
Changes the thumbnail size to 
fit them into the window.

View Image Button
Displays the selected image 
or movie in the Viewer 
Window.

Slide Show Button
Starts a slide show of the 
selected images.

Properties Button
Displays information about 
the selected image in the 
Properties Window.

Search Button
Searches for images 
using such criteria as the 
Star Rating, 
modification date, 
shooting date, 
comments or keywords.

Delete Button
Deletes selected 
images or folders.

Rotate Button
Rotates the selected 
image.
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.

• If a RAW image is displayed, the [Display Original Image] button displays 
beneath it. Clicking this button displays the converted image in the Viewer 
Window.

•With Windows Vista and Windows XP, when a movie file is displayed, the 
 (Capture Still Frame) button will display beside the Star Ratings. Clicking 

this button extracts still images from movies.

Edit Menu
You can edit, eliminating red eyes, 
adjusting colors and brightness, 
cropping and inputting titles. You can 
also use it to start up other programs 
for editing. 

Image Selector 
Button
Switches between 
images.

Full Screen Button
Displays the image in the full screen mode. Click the 
image or press any key on the keyboard to restore the 
normal display mode.

Synchronize Button
Synchronizes the 
display settings when 
multiple images are 
displayed. 

Star Rating
Sets the Star Rating for an image.

Zoom
Changes the image 
zoom setting.

Number of 
Displays 
Button
Displays 
multiple 
images at 
once. This is 
handy for 
comparing 
images.

Sets the image 
display size to the 
size in the Viewer 
Window. 

Displays images in 
the Viewer 
Window at their 
actual size. 

Print Button 
Prints the displayed image.

Shooting 
Information 
Display Button
Displays image 
shooting 
information.
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Properties Window
The Properties Window displays when you select an image in the Browser Area and click the 
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides 
categories.

Star Rating
Sets the rating 
for an image.

Shooting Information
Displays detailed 
information, such as the 
shutter speed and 
exposure compensation 
setting. The camera model 
will determine what 
information is displayed. 

Protect
Prevents an image from being 
overwritten or deleted.

Comment
You can type a comment here.

Keywords
Sets the keywords used in 
searches.

Brightness Histogram
A graph of the highlights and 
shadows distribution in an 
image.

Image Selector Buttons
Switches between images.

Plays a sound memo attached 
to an image.

File Name
The file name 
can be changed.
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ZoomBrowser EX Features
This section briefly introduces the Task Area functions.

Acquire & Camera Settings
Opens the Camera Control Window, which lets 
you perform the following operations.

Connect to Camera
Connects to your camera and lets you perform the following operations.

•Acquire Images
Downloads images and sound files from the camera (p. 16).

•Print Images 
Selects and prints the images in a camera. You can print numerous ways, using DPOF 
settings, print all images, the Index Print option, One Photo per Page Print option, or by 
selecting images before printing.  

•Set to Camera 
Sets camera settings, such as the My Camera settings (p. 39). It also uploads images from 
the computer to the camera.

•Remote Shooting
Allows you to operate the camera shutter from the computer (p. 35).

Connect to EOS Camera
This can only be used with EOS series cameras. For details on this function, see the user guide 
for your camera. (Windows Vista and Windows XP only)

Acquire Images from Memory Card
Download images and sound files from a memory card (p. 19).
You can also select images on the memory card and print them.

View & Classify
View as a Slide Show
Starts a slide show of the images selected in the 
Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder. 

Search 
Performs image searches using criteria such as the Star Rating, modification date, shooting 
date, comments or keywords. Star Ratings, comments and keywords can be set in the image 
information column in the Preview Mode or in the Properties Window. 

Some functions may not be available with certain camera models. Check your 
Camera User Guide to see if your model supports them. 
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Edit
Edit Image
Allows you to perform image editing, such as 
cropping, image correction and red-eye 
correction. You can also use it to start other image editing programs. 

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 38).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music, 
and apply various effects (p. 34).

Process RAW Images
Converts RAW images into standard images. You can adjust the image brightness, contrast 
and color balance among other attributes during conversion.

Export
Export Still Images
Allows you to change the image size or type, 
and export it as a new image. 

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Extract frames from a movie
Extracts still images from movies over a specified interval and saves them as image files.
 (Windows Vista and Windows XP only)

Export Shooting Properties 
Allows you to select the necessary data from the shooting information and export it as a text 
file. 

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.
(Windows Vista and Windows XP only)

The Backup to CD function can only be used on computers satisfying the 
following requirements. 
•A CD-R/RW drive is included as standard equipment
•The write to CD-R/RW Driver function operates correctly on the Windows 

Vista and Windows XP platforms
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Print
One Photo per Page Print
Prints one image per page (p. 21).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Internet
Email Images
Converts the selected images to the 
appropriate size for transmission by e-mail. You 
can also use it to automatically start an e-mail program after conversion.

•To return to the previous screen after selecting a task, click [Return to Main 
Menu] at the bottom of the task screen. 

•Various Help functions are available in ZoomBrowser EX. Click the [Help] 
menu, [?] button or [Help] button to display topics about operational 
procedures or the functions available.
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Replaying Movies

1 Double-click a thumbnail image with a movie icon in ZoomBrowser EX’s Browser 
Area.
The Viewer Window will open and play the movie.  

QuickTime is required to play and edit movies on the Windows 2000 platform.

You can save the displayed 
scene as a still image by 
clicking here.

You can control the 
movie's playback and 
sound volume.
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Click [Edit] in ZoomBrowser EX’s Main Window, followed by [Edit Movie].

2 Click [1. Add Images] and select the image (movie or still) you wish to edit. 
You can select multiple movies or stills.

3 Follow the steps at the left of the window to edit the movie and save it. 

•QuickTime is required to play and edit movies on the Windows 2000 
platform.

•Movies are saved as Motion JPEG AVI movies.

Click this button to 
play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the selected 
images.
Links images in order from left to right.

Click this button for detailed 
operational instructions.

Transition Effects Box
Appears between adjacent images 
and displays the symbols of the 
transition effects linking images.

Instructions
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Operating the Shutter Remotely (Remote 
Shooting)
You can record still images by using a computer to control the shutter of a connected camera. 
This is particularly useful for checking images on the larger display of the computer as you 
record them and for high volume photography without worrying about filling the camera’s 
memory card.

Preparing for Remote Shooting
1 Attach the supplied interface cable to the computer's USB port and the camera's 

DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
 Proceed to the next step if your model does not have one. 

3 Click the [Remote shooting] tab.

4 Click [Starts Remote Shooting].

5 Select a destination for the captured images and click [OK].

This function may not be available with certain camera models. Check your 
Camera User Guide to see if your model supports it. 

•Methods for connecting the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. Please 
refer to the Camera User Guide.

•Perform the settings described in First Time Camera is Connected to a 
Computer (p. 17) the first time you connect the camera to the 
computer.
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RemoteCapture Task Window 
The RemoteCapture Task window has the following features.

The settings available in the RemoteCapture Task window vary between 
camera models. 

Size and Resolution Selector
Selects the size and resolution at which images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or detailed 
settings area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click  and check the subject in the viewfinder.
2 Change the image size or resolution, the rotation settings and the settings at the 

bottom of the window as required. 
If you intend to hold the camera vertically to photograph a subject, you can save the 
image to the computer with the correct orientation if you set the rotation settings in 
advance. 

3 Click the [Release] button.

Ensure that you turn off your computer’s standby mode before you begin 
remote shooting. The device performance cannot be guaranteed if the 
computer enters the standby mode.

If your camera is equipped with the Auto Rotate function and you set it 
to On, the image will automatically be rotated and appear in the correct 
viewing orientation in the RemoteCapture Task window when holding 
the camera vertically.

•You can release the shutter by pressing the camera’s shutter button or 
the keyboard’s space key.

•Other than the shutter button, the camera's buttons and switches, 
including the zoom, cannot be operated while the camera is being 
controlled with the Remote Shooting function. 

•You may notice that the interval between the shutter release and 
activation is slightly longer for remote shooting than when the camera 
is used independently. 



Using the Software on the Windows Platform – Advanced Techniques 38
W

indows

Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging images of a scene shot separately. 
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the 
size and orientation. You can also manually specify the overlapping areas. 

1 Click [Edit] in the ZoomBrowser EX’s Main Window and click [Stitch Photos].

2 Click [1. Select Images] and select several images in the Browser Area.

3 Click [2. Open PhotoStitch]. 

Instructions

4 Merge the images following the instructions in the guidance panel at the top of 
the PhotoStitch window.

Images Shot in Stitch Assist Mode
It is easy to merge images if they are shot with the camera's Stitch Assist 
mode because PhotoStitch can automatically detect the image order and 
orientation. The series of images are saved together in a single folder 
when they are downloaded from the camera.

•Some camera models may not support Stitch Assist mode. 
•See the Camera User Guide for information about shooting in Stitch Assist mode.
• Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up lens 

cannot be merged accurately. 

Symbol displayed by images 
shot in Stitch Assist mode.
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Enjoy Customizing Your Camera with the My 
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera settings. You can add your favorite images and sounds from your 
computer to the My Camera settings. This topic explains how to upload the My Camera 
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window
1 Attach the supplied interface cable to the computer's USB port and the camera's 

DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display. 

2 Click the [Set to Camera] tab. 

3 Click [Set My Camera].
The My Camera window will display. 

This function may not be available with certain camera models. Check your 
Camera User Guide to see if your model supports it. 

To register the My Camera settings with the camera, ensure that you install 
the software that came with the camera.

•Methods for connecting the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. Please 
refer to the Camera User Guide.

• Perform the settings described in First Time Camera is Connected to a 
Computer (p. 17) the first time you connect the camera to the computer.  
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The My Camera Window Features
ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check 
these items with the My Camera window.

Depending on the camera, the [Return to 
factory default settings] button will display. 
Clicking this button will return the My Camera 
setting to the factory default setting.

Tabs 
Click here to switch between adjusting the settings individually or in themed sets.

Computer
Displays the list of 
settings files saved 
onto the computer.

Play Button
Plays the audio from 
the selected settings 
file.

Delete Button
Deletes a settings file from 
the computer.
The pre-recorded My Camera 
settings in ZoomBrowser EX 
cannot be deleted (Windows 
Vista only).

Delete Button
Deletes a settings file 
from the camera.

Camera
Displays the settings in 
the camera.

Play Button 
Plays the audio from the 
settings file in the 
camera.

Save to Camera Button
Saves a computer 
settings file onto the 
camera.

Save to PC Button
Saves a camera settings 
file onto the computer.
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Saving the My Camera Settings to the Camera

1 Select the [Setup as a theme] tab in the My Camera window. 
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings file you wish to save to the camera from the My Computer list. 
3 Select the setting from the Camera list that you would like to change and click 

[Save to Camera].
This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten. 

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions.
 

Saving the Camera’s My Camera Settings to the Computer
1 Select the [Setup as a theme] tab in the My Camera window. 

To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings files from the Camera list that you wish to save to the 
computer.

3 Click [Save to PC].
4 Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

•My Camera settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera settings themes all begin with the same root 
name. The start-up image and sound files in the “Animal” theme, for 
example, all begin with “Animal~”. 

Do not detach the interface cable, turn the camera power off or do anything 
else that could disconnect the camera from the computer while the My 
Camera settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
•Adding Image and Sound Files After Creating Them

Adding Original Start-up Images and Sounds After Creating Them
You can effortlessly create start-up image and sound files using the "My Camera Maker" 
program. 

1 Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage 
My Camera]. 
The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create 
My Camera Data] button.
My Camera Maker will start.

3 Follow the instructions at the top part 
of the My Camera Maker window and 
create image or sound files.  

Instructions

Add File Button
Adds images and sound files for use 
as settings files. Added files display 
in the list.

Connect to camera Button
Connects to the camera. 
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4 Once you have saved the file, click  and close the My Camera Maker window.
You have now succeeded in adding the file as a settings file to the computer.

5 To connect to the camera, click 
[Connect to Camera]. 
You can add the settings files you just 
added to the computer to the camera using 
the same procedures as in Saving the My 
Camera Settings to the Camera (p. 41).

•Use settings like those below when creating an image file for the start-
up image using an image editing program other than “My Camera 
Maker”.

Compression Method : JPEG (Baseline JPEG)
Data Sampling : 4:2:0 or 4:2:2 
Pixels (w x h) : 320 x 240 pixels

•Use settings like those below when creating a sound file using a sound 
recording program other than “My Camera Maker”.

Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz

Use the following lengths as guidelines for the length of sound file that 
can be saved to the camera.    

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Using the Software on the Macintosh 
Platform – Preparations

This chapter explains the basic procedures for installing the software. Read this material before 
you connect the camera to the computer for the first time.

Installing the Software
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare
•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Close any programs that are running. 
2 Place the Canon Digital Camera Solution Disk in the 

computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon 

 in the CD-ROM window.

4 Click the Digital Camera Software 
[Install] button. 

Installer Panel
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5 Select [Easy Installation] and click 
[Next].

Select [Custom Installation] to select 
programs individually for installation. 

6 Click [Agree] if you agree to all of the 
terms of the software license 
agreement.

7 Review the installation settings and 
click [Next].
Follow the on-screen instructions to 
proceed with the installation.

8 When the installation is over, click [OK].

9 Click [Exit] in the installer panel and 
remove the disk from the CD-ROM drive. 
This concludes the software installation. 

Continue by downloading images to the computer (p. 46). 

See Uninstalling the Software (p. 72) to delete the software installed 
with these procedures.
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Using the Software on the Macintosh 
Platform – The Basics

This chapter explains the procedures for using ImageBrowser to download the camera's images 
to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the 
Macintosh Platform – Preparations section. 

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly 
different according to whether you are using a camera to computer connection (see below) or 
a memory card reader (p. 48).

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL Terminal. Prepare the camera for communication with the computer. 

The Camera Control Window will appear.
If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of 
the desktop). To set this window so it does not automatically open when you connect the 
camera to the computer, remove the check mark from the [Start when a camera is 
connected] in the [File] menu in the Camera Control window.

You may not be able to download images when the camera is connected to a 
computer if there are a large number of images (approximately 1000) on the 
memory card. Use a memory card reader to download in that case.

Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See the 
Camera User Guide. 
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2 Download images.
Download the images using the camera or 
the computer. By default, the downloaded 
images are saved into the [Pictures] folder.

Camera Control Window

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences]. 

Using the Camera to Download Images (Direct Transfer Function)

 
Set the Direct Transfer settings on the 
camera and press the  (Print/Share) 
button or the FUNC./SET button.

Using the Computer to Download Images
Click [Starts to download images].

• If the conditions are right for the Direct Transfer function, the Direct 
Transfer settings menu will appear in the LCD monitor. In addition, the  

 (Print/Share) button will light if your camera is equipped with one. 
•See the Camera User Guide for instructions regarding Direct Transfer 

settings and procedures. 
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The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired 
Images] at the top of the Explorer Panel.

Next, print out the images (p. 50).

Memory Card Reader Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the 
reader.

The Camera Control Window will appear.

If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of 
the desktop). To set this window so it does not automatically open when you connect the 
camera to the computer, remove the check mark from the [Start when a camera is 
connected] in the [File] menu in the Camera Control window.

•By default, all the images that have yet to be downloaded will download.
•To download images that have had their transfer settings set with the 

camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded. 

•Click [Lets you select and download images] to show the camera images 
in a list, check the images before downloading and download only 
selected images.

Thumbnail
According to the default settings, the thumbnails 
(tiny versions) of the downloaded images display in 
the Browser Window when the downloading is 
complete.

Destination for the 
downloaded images
The downloaded symbol 
displays on downloaded 
folders.  

[Last Acquired Images]
Clicking the shooting date 
displays the images last 
downloaded.

Explorer Panel
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2 Click [Starts to download images].

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences]. 

The downloaded images are saved into folders according to the shooting date.

At the same time, they will also appear grouped by date in the [Last Acquired Images] at 
the top of the Explorer Panel.

Next, print out the images (p. 50).

•By the default settings, all images are downloaded to the [Pictures] 
folder.  

•To download images that have had their transfer settings set with the 
camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded. 

•Click [Lets you select and download images] to show the memory card 
images in a list, check the images before downloading and download 
only selected images.

•See Memory Card Folder Structure (p. 75) for information about 
memory card folder structures and file names.
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Printing Images
There are three ways in which images may be printed: One Photo per page Print, Index Print 
and Layout Print. This section explains the One Photo per page Print method.

One Photo per page Print
This option prints one image per page in a standard "photo" format. If you select multiple 
images, it will print them on the corresponding number of pages.

1 Select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple 
images, hold down the [shift] or [ ] (command) key while clicking on images.

2 Click [Print] and select [One Photo per 
page Print].

Movies cannot be printed, but you can print stills after they have been 
extracted from movies and saved to files. 

Selecting [Index Print] allows you to print the thumbnails and shooting 
information in a chart.
Selecting [Layout Print] allows you to layout and print multiple images on 
a single sheet of paper.

A blue frame 
displays around 
selected images.
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3 Set the categories as you feel necessary.

4 Click [Print].
The Print window will now open.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click  to close the window.

This chapter explained the ImageBrowser basics. 

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform – Advanced Techniques (p. 52).

Selects a printer.

Selects options such as the paper size 
and orientation when you click 
[Page Setup].

Configures the auto trimming 
function.

Place a check mark here to print the 
shooting dates/times with the 
images.

Sets the number of copies printed.

Click this button to switch between 
images if you selected multiple 
images.
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Using the Software on the Macintosh 
Platform – Advanced Techniques

This chapter explains various ImageBrowser features. 
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the 
Using the Software on the Macintosh Platform – The Basics chapter.

The ImageBrowser Windows
This section describes the principal ImageBrowser windows: the Browser Window, Viewer 
Window and File Information Window.

Browser Window
This window is for displaying and organizing images downloaded to the computer.

Explorer Panel (p. 53)

Browser Area (p. 53) Display Mode (p. 54)

Display Control Panel (p. 55) Control Panel (p. 55)
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Explorer Panel 
•Use this area to select folders. The images in the selected folder display in the Browser Area.
• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will 

display. You are recommended to register a folder that you use frequently as one of the 
Favorite Folders. If you selected All Folders, all the folders will display. 

•Downloaded images also appear in the [Last Acquired Images] area at the top of the Explorer 
Panel. You can check them in groups sorted by shooting date. 

Browser Area
•The images in the folder selected in the Explorer Panel will display here.

The display style will vary according to your Display Mode selection. 
•The following types of icon will display around images according to their attributes.

Images shot with the camera's Stitch Assist mode 

RAW images

Movies

Images with sound memo attachments

Protected images

Images shot with the camera's AEB function

Rotated Images (In display only)

Methods for Registering a Favorite Folder
• If [Favorite Folders] is displayed: click [Add] and select a folder. 
• If [All Folders] is displayed: select a folder and click [Add to Favorites].

Using Cameras That Support My Category
• In addition to classifying by Shooting Date, My Category also displays at the top of the 

area where the [Last Acquired Images] message displays after the last image is 
downloaded.

•Also, in addition to the Star Rating it is possible to sort by My Category using the [Filter 
Tool] function.
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Display Mode
•Selects the display style for the Browser Area.

Preview
This mode displays the image at a larger size as 
well as the image information. 

List
Displays the images in the folder selected in the 
Explorer Panel section in rows and columns.

TimeTunnel 
Displays images in chronological order in a 
simulated time tunnel. You can move along a 
timeline from the past to the present using the 
slider that appears at the window's right.
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Display Control Panel 
•This panel adjusts the display settings for the Browser Area.

Control Panel
•The control panel contains buttons for executing various functions. 

The functions displayed here are explained in the Control Panel Features section (p. 58).

Selection Menu
Click this to select/deselect all 
images in the Browser Area. 

Hide Buttons
Left: Hides the Explorer Panel.
Middle: Hides the control panel. 
Right: Hides the image 

information in the Preview 
display mode.

Display Size
Changes the size of the thumbnail in 
the Browser Area.

Filter Tool Menu
Use the Star Rating option in the Show menu 
to limit the scope of images displayed.
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.

• If a RAW image is displayed, the [Show Original Image] button displays 
beneath it. Clicking this button displays the converted image in the Viewer 
Window.

• If a movie file is displayed, the [Save as Still Image] button will display 
beneath movie images. Click this button to extract a still image from the 
movie.

Edit Menu
You can edit, eliminating red eyes, 
adjusting colors and brightness, cropping 
and inputting titles.
You can also use it to start up other 
programs for editing. 

Image Selector Button
Switches between 
images.

Zoom
Changes the 
image zoom 
setting.

Full Screen Button
Displays the image in the full screen 
mode. (You can also double-click an 
image to display it in full screen mode). 
Click the image or press any key on the 
keyboard to restore the normal display 
mode.

Synchronize Button
Synchronizes the display 
settings when multiple 
images are displayed. 

Star Ratings 
Menu
Sets the Star 
Rating for an 
image.

Number of Displays Menu
Displays multiple images at 
once. This is handy for 
comparing images.

Save Button
Saves the edited image.

Show Information Menu
Displays shooting 
information.

Print Button 
Prints the displayed image.



Using the Software on the Macintosh Platform – Advanced Techniques 57
M

acintosh

File Information Window
The File Information Window displays when you select an image in the Browser Area, click the 
[File] menu and select [Get Info]. The File Information Window does not display in the Preview 
display mode.

Plays a sound 
memo attached 
to an image.

Star Rating
Sets the rating for an image.

Shooting Information
Displays detailed information, such 
as the shutter speed and exposure 
compensation setting. The camera 
model will determine what 
information is displayed. 

Lock 
Prevents an image 
from being 
overwritten or 
deleted.

Comment
You can type a comment 
here.

Keyword
Sets the keywords used in 
searches.

Brightness Histogram
A graph of the highlights 
and shadows distribution 
in an image.

Image Selector Buttons
Switches between images.

Shows or hides 
categories.

File Name
You can change 
file names.
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ImageBrowser Features
This section provides a brief introduction to ImageBrowser features.

Control Panel Features

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images
Downloads images and sound file from the camera/memory card (p. 46, 48).

Print
Selects and prints the images in a camera or memory card. You can print numerous ways: 
print all images, print a contact sheet (index) of all images, print using DPOF settings, or by 
selecting images before printing. 

Set to Camera 
Sets camera settings, such as the My Camera settings (p. 67). It also uploads images from the 
computer to the camera. 

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 63).

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow
Starts a slide show of the selected images. Click the [View] menu and select [Slide Show 
Options] to set the slide show settings.

Internet 
Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also 
use it to automatically start an e-mail program after conversion. 

Some functions may not be available with certain camera models. Check 
your Camera User Guide to see if your model supports them. 
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Print
One Photo per page Print
Prints one image per page (p. 50).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert 
captions and titles. 

Send to Trash
Sends the selected images or folders to the Trash.

Functions Selected from Menus
Search Images: [File] menu, [Search]

Searches for images based on such criteria as Star Ratings, dates, keywords or captions. 

Export Images: [File] menu, [Export Images]
•Edit and Save: allows you to change the file type or size and export the file.
•Export Shooting Properties: allows you to export the shooting properties as a text file.
•Export as a Screensaver: Exports the image as a screen saver file.
•Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]
•Sort Images: sorts images according to criteria such as the shooting date or Star Rating and 

saves them into a specified folder.
•Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]
Converts RAW images. You can adjust the image brightness, contrast and color balance 
among other attributes during conversion.

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 66).

Edit Movies: [Edit] menu, [Movie Edit]
Edits movies or still images strung together. You can add titles or background music and 
apply various effects (p. 62).

Extracting Stills from Movies: [Edit] menu, [Extract frames from a movie]
Extracts still images from movies over a specified interval and saves them as image files. 
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Display Settings: [View] menu, [View Settings]
Hides or shows image information beneath the thumbnail, such as the file name or the 
shooting date and time.

Sort Images: [View] menu, [Sort]
Arranges image order in the Browser Area according to criteria such as the filename, file 
modification date, file size or shooting date.



Using the Software on the Macintosh Platform – Advanced Techniques 61
M

acintosh

Replaying Movies
1 Double-click an image with a movie icon in ImageBrowser’s Browser Area.

The movie will appear in the Viewer 
Window. 

Movie icon

2 Click the  button.

You can save the displayed scene 
as a still image by clicking here.

You can control the 
movie's playback and 
sound volume.
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Select the image(s) to edit in ImageBrowser’s Browser Area (movies or stills). 
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit]. 

3 Follow the steps displayed in the middle of the window to edit the movie and save 
it. 

Click this button 
to play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the 
selected images.
Links images in order from 
left to right.

Click this button 
for detailed 
operational 
instructions.

Transition Effect Box
Appears between adjacent 
images and displays the 
symbols of the transition 
effects linking images.

Instructions
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Operating the Shutter Remotely (Remote 
Shooting)
You can record still images by using a computer to control the shutter of a connected camera. 
This is particularly useful for checking images on the larger display of the computer as you 
record them and for high volume photography without worrying about filling the camera’s 
memory card.

Preparing for Remote Shooting
1 Attach the supplied interface cable to the computer's USB port and the camera's 

DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display. 

2 Open the lens cover or remove the lens cap on models equipped with them. 
Proceed to the next step if your model does not have one. 

3 Click the [Remote shooting] tab.

4 Click [Starts Remote Shooting].

5 Select a destination for the captured images and click [Choose].

This function may not be available with certain camera models. Check your 
Camera User Guide to see if your model supports it. 

•Methods for connecting the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. Please 
refer to the Camera User Guide.

• If the Camera Control Window does not automatically appear, click the 
[CameraWindow] icon in the Dock (the bar at the bottom of the 
desktop).  
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RemoteCapture Task Window 
The RemoteCapture Task window has the following features.

The settings available in the RemoteCapture Task window vary between 
camera models. 

Size and Resolution Selector
Selects the size and resolution at which 
images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the camera shooting settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or 
detailed settings 
area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click  and check the subject in the viewfinder.
2 Change the image size or resolution, the rotation settings and the settings at the 

bottom of the window as required. 
If you intend to hold the camera vertically to photograph a subject, you can save the 
image to the computer with the correct orientation if you set the rotation settings in 
advance. 

3 Click the [Release] button.

Ensure that you turn off your computer’s sleep mode before you begin remote 
shooting. The device performance cannot be guaranteed if the computer 
enters the sleep mode.

If your camera is equipped with the Auto Rotate function and you set it 
to On, the image will automatically be rotated and appear in the correct 
viewing orientation in the RemoteCapture Task window when holding 
the cameras vertically.

•You can also release the shutter by pressing the camera’s shutter button 
or the keyboard’s space key.

•Other than the shutter button, the camera's buttons and switches, 
including the zoom, cannot be operated while the camera is being 
controlled with the Remote Shooting function. 

•You may notice that the interval between the shutter release and 
activation is slightly longer for remote shooting than when the camera 
is used independently. 
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Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging images of a scene shot separately. 
PhotoStitch automatically detects the overlapping areas of adjacent images and corrects for the 
size and orientation. You can also manually specify the overlapping areas.  

1 Select a series of images in the ImageBrowser’s Browser Area. 
2 Click the [Edit] menu and select 

[PhotoStitch].

Instructions

3 Merge the images following the instructions in the guidance panel at the top of 
the PhotoStitch window.

Images Shot in Stitch Assist Mode
It is easy to merge images if they are shot with the camera's Stitch Assist 
mode because PhotoStitch can automatically detect the image order and 
orientation. The series of images are saved together in a single folder 
when they are downloaded from the camera.

•Some camera models may not support Stitch Assist mode. 
•See the Camera User Guide for information about shooting in Stitch Assist mode.
• Images shot in Stitch Assist mode with a wide converter, teleconverter or close-up lens 

cannot be merged accurately. 

Symbol displayed by images 
shot in Stitch Assist mode.
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Enjoy Customizing Your Camera with the My 
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera settings. You can add your favorite images and sounds from your 
computer to the My Camera settings. This topic explains how to upload the My Camera 
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window
1 Attach the supplied interface cable to the computer's USB port and the camera's 

DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display. 

2 Click the [Set to Camera] tab. 

3 Click [Set My Camera].
The My Camera window will display. 

This function may not be available with certain camera models. Check your 
Camera User Guide to see if your model supports it. 

To register the My Camera settings with the camera, ensure that you install 
the software that came with the camera. 

•Procedures for attaching the camera to the computer and placing it in 
the correct mode for connecting vary between camera models. See the 
Camera User Guide.

• If the Camera Control Window does not automatically appear, click the 
[CameraWindow] icon in the Dock (the bar at the bottom of the 
desktop). 
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The My Camera Window
ImageBrowser already contains several pre-recorded My Camera settings. You can check these 
items with the My Camera window.

Depending on the camera, the [Return 
to factory default settings] button will 
display. Clicking this button will return 
the My Camera setting to the factory 
default setting.

Type 
Select the settings type. 

Computer
Displays the list 
of settings files 
saved onto the 
computer.

Play Button
Plays the audio from the 
selected settings file.

Send to Trash Button
Deletes a settings file 
from the computer.

Save to Camera Button
Click here to save the 
settings onto the 
camera.

Delete Button
Deletes a settings 
file from the 
camera. 

Camera
Displays the settings 
in the camera.

Play Button 
Plays the audio from 
the settings file in the 
camera.

Save to Camera
Save to Computer 
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Saving the My Camera Settings to the Camera

1 Select the type of setting in the Type list box that you wish to save to the camera.
2 Select the setting from the Computer list that you would like to add.
3 Select the setting in the Camera list that you would like to change and click the 

 button.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.
This concludes the process of saving the My Camera settings to the camera. 
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions. 

Saving the Camera’s My Camera Settings to the Computer
1 Select the type of setting you wish to save to the computer from the Type list box.
2 Select the setting in the Camera list that you wish to save to the computer. 
3 Click the  button.
4 Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer. 
Repeat steps 1-4 as required.

•My Camera settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera settings themes all begin with the same root 
name. The start-up image and sound files in the “Animal” theme, for 
example, all begin with “Animal~”. 

Do not detach the interface cable, turn the camera power off or do anything 
else that could disconnect the camera from the computer while the My 
Camera settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
•Adding Image and Sound Files After Creating Them

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up 
image and save it to the computer. 

1 Click the [File] menu in the ImageBrowser Main Window and select [Canon 
Camera] and [My camera].  
The My Camera window will display.

2 Select the [Start-up Image] in Type.

3 Click [Add].

4 Select the file you created and click [Open].
This concludes the process for adding new data.

5 To connect to the camera, click [Connect to Camera]. 
You can add the settings files you just added to the computer to the camera using the 
same procedures as in Saving the My Camera Settings to the Camera (p. 69).

Add Button
Adds images and 
sound files for use as 
settings files. Added 
files display in the list.

Connect to Camera Button
Connects to the camera. 
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Add an Original Sound File
Change the file to a WAV sound file after you have copied the sound file to the computer. 
Then proceed with the steps as described in Create an Original Start-up Image File and then 
Add It.

•Use settings like those below when creating an image file for the start-
up image with an image editing program.

Compression Method : JPEG (Baseline JPEG)
Data Sampling : 4:2:0 or 4:2:2 
Pixels (w x h) : 320 x 240 pixels

•Use settings like those below when creating a sound file with a sound 
recording program.

Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz

Use the following lengths as guidelines for the length of sound file that 
can be saved to the camera.  

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Appendices

This chapter explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the 
programs.

Uninstalling the Software
The procedures for uninstalling the software are only required when you wish to delete the 
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can 
remove other programs with the same procedures. 

1 Click the Windows [Start] menu and 
select [All Programs] or [Programs], 
followed by [Canon Utilities], 
[ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

The uninstall utility will start and remove 
ZoomBrowser EX.

Authorization as a computer Administrator is required to uninstall software.
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Uninstalling the USB Driver (Windows)

Windows Vista, Windows XP 
You do not need to uninstall the USB driver.

Windows 2000 
Uninstall the USB Driver using the following procedures.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL Terminal. Prepare the camera for communication with the computer.
For interface cable connection instructions, see the Camera User Guide. 

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select 
[Settings], followed by [Control Panel].

4 Double-click the [Scanners and 
Cameras] icon.

It is essential to note that you will not be able to download images if you 
uninstall the USB driver.
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5 Select your camera model name or 
[Canon Camera] in the [Scanners and 
Cameras Properties] dialog, and click 
[Remove].

6 Click the Windows [Start] menu and select [Programs], followed by [Canon 
Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A version 
number appears in place of the “x.x”.

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following 
procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the interface cable. 

Uninstalling the Software (Macintosh)
Uninstall the programs by dragging the application’s folder (the folder in which it was installed) 
into the Trash, and then empty the Trash.

If your camera model name does not appear here, see the Camera not 
detected, Events dialog won’t display or images will not download to the 
computer (p. 77) of the Troubleshooting section.

Please be careful not to accidentally delete any folders with downloaded 
images that may be contained within the application folder. 



Appendices 75
W

indows/M
acintosh

Memory Card Folder Structure
The images on a memory card are placed in subfolders of the [DCIM] folder labeled 
[xxxCANON], where the “xxx” represents a number in the range 100 - 999. 

•*Files with the THM extension are the thumbnail image files for the camera’s index replay 
mode.

•The “xxxx” in file names represent four-digit numbers.
•**Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which 

is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG], 
[STC_0003.JPG]...

•All folders except the “xxxCANON” folders contain image settings files. Do not open or delete 
them. 

IMG_xxxx.JPG (JPEG images)
_MG_xxxx.JPG (JPEG images recorded in the 
Adobe RGB color space)
CRW_xxxx.CRW (RAW images)
_RW_xxxx.CRW (RAW images recorded in the 
Adobe RGB color space)
CRW_xxxx.THM*
STx_xxxx.JPG** (Stitch Assist mode images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*
SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for 
images in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

DCIM

MISC

xxxCANON

CANONMSC

SNDR xxxCANON

SDR_xxxx.WAV (Files recorded with Sound Recorder)
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Troubleshooting
Please read this section if you encounter a problem using the software.

Start by Checking This
Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System 
Requirements section (p. 8)?

Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also 
check to ensure that you are using the correct cable and that it is securely 
attached at both ends. 

Are the camera and computer in the correct modes to transfer data?

Some models require the camera to be set to the playback mode to 
transfer data. See the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. 
You are recommended to use a household power source (AC adapter) to 
power the camera when it is connected to a computer.
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Problems
Try the suggested solutions to the common problems listed below.

USB driver installation not proceeding well (Windows 2000).

Uninstall the driver (p. 73) before reinstalling it with the procedures in Installing 
the Software and USB Driver (p. 11). 

Add New Hardware Wizard or New Hardware Found (Windows 2000) 
Wizard displays when the camera is connected to the computer with an 
interface cable (Windows).

Click [Cancel] to close the window. Temporarily disconnect the camera from the 
computer. Next, read Start by Checking This on the previous page and resolve 
the problem.

Cannot download images or shoot remotely. (For cameras connected to 
the computer via an interface cable: only cameras supporting Hi-Speed 
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by 
following the procedures below.
Solution:
Hold the MENU button on the camera down and press the  (Print/Share) 
button and FUNC./SET button simultaneously. In the displayed screen, select [B] 
and press the FUNC./SET button.

Images won’t download into a TWAIN-compliant program (Camera and 
computer connected via interface cable (Windows 2000)).

Click the [Finish] button in the Camera Control Window to close it.

Camera not detected, Events dialog won’t display or images will not 
download to the computer (when camera is connected to the computer 
via an interface cable (Windows)).

Cause 1:
The USB Driver may not be correctly installed (Windows 2000).
Solution:
Install the USB driver with the procedures in Installing the Software and USB 
Driver (p. 11). Then connect the camera to the computer with the interface 
cable and prepare it to transfer data. If the USB driver is already installed, 
uninstall (p. 74) it first and then reinstall it.
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Cause 2:
The camera may have been recognized as another device under the 
following circumstances (Windows only).
• The camera was connected to the computer before the USB driver was 

installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot 

be found in the [Control Panel] or the [Printers and Other Hardware] window.
• Your camera model name, [Canon Camera] or a camera icon does not display 

in the [Scanners and Cameras Properties] dialog or the [Scanners and 
Cameras] folder.

Solution:
Delete the device with the following procedures. 

 

1. Display the [Device Manager] dialog.
Windows Vista: Click the [Start] menu, [Control Panel], [System and 
Maintenance], [System], and Task list [Device Manager].
Windows XP: Click the [Start] menu, [Control Panel], [Performance and 
Maintenance], [System], [Hardware] tab, and the [Device Manager] button.
Windows 2000: Click the [Start] menu, [Settings], [Control Panel], [System], 
[Hardware] tab, and the [Device Manager] button.

2. Click the  symbol beside the [Other devices], [Portable Devices] and/or 
[Imaging devices] category.
Your camera model name or [Canon Camera] will display in these categories 
if it is being recognized as an “other” device.

3. Select your camera model name or [Canon Camera], right-click and select 
[Delete].

You must be authorized as a Computer System Administrator to delete 
devices. 

There are other potential reasons for the problem if the “Other 
devices”, “Portable Devices” or “Imaging devices” categories do not 
appear or your camera model name or [Canon Camera] does not appear. 
Proceed to Step 5, and temporarily quit the procedures.



Appendices 79
W

indows/M
acintosh

4. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

5. Close [Device Manager] or [System Properties].

With Windows 2000, continue by deleting the setup information file. 

6. Double-click the [My Computer] icon on the desktop, followed by the [C:] 
drive, [WINNT] folder and [inf] folder.

7. Look for files for Canon digital cameras that start with [CAP*]. 
The “*” represents a number, such as 0 or 1. 
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files, “*“ represents 
the same number (For example, [CAP0.inf] and [CAP0.pnf]). 

Step 6 and above are not required for Windows Vista and Windows XP.

If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

1. Open the [WINNT] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files 

and folders] to [Show hidden files and folders]. Remove the check marks from [Hide 
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Double-click the [CAP*] files to check their contents. 
Double-clicking a [CAP*.inf] file will open it in the Windows Notepad 
program. Check all files, and look for [;****Canon Camera Driver Setup 
File****] in the first line. Note down the names of these files.

9. Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you 
noted down in Step 8.

10.Reinstall the driver with the procedures in Installing the Software and USB 
Driver (p. 11).

Zooming Images in ZoomBrowser EX is Slow or Not Working
Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX 
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration 
setting to a lower setting. 

1. Click the Windows [Start] menu, followed by [Control Panel].
With Windows 2000, click the [Start] menu and select [Settings], followed by 
[Control Panel]. 

2. Display the [Hardware acceleration] setting window.

Windows Vista: Click [Appearance and Personalization], followed by [Adjust 
screen Resolution], [Advanced Settings] button and [Troubleshoot] tab.

Windows XP: Click the [Appearance and Theme] icon, followed by the 
[Display] icon, [Settings] tab, [Advanced] button and [Troubleshoot] tab.

Windows 2000: Click the [Display] icon, followed by the [Settings] tab, 
[Advanced] button and [Troubleshoot] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

Several sets of [CAP*] files may be present in the [inf] folder. Open up 
each file to confirm that it is an [CAP*] file for Canon digital cameras 
before you do anything with the file.

The [inf] folder contains numerous files critical to the computer’s 
operation. Be extremely careful to delete the correct files. If you delete 
the wrong files, you may be unable to restart Windows.
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An error message "Insufficient free memory" displays when 
using PhotoStitch

Please try one of the following methods.

•Close all other applications other than PhotoStitch.
•Reduce the size or number of images to combine.
• In the [Save] tab, select [Adjust image...], then in “Saved Image Size“ reduce the size.

If You Were Using ZoomBrowser EX Version 2 or 3
Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you 
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in 
which you installed ZoomBrowser EX 5. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility. 
With Windows Vista, right-click the [dbconverter.exe] file and proceed with 
authorization as a computer Administrator. 

3. Select the database file you were using up to this point and click the [Start] 
button. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

This will display the titles and comments input in the earlier versions in the 
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed in 
ZoomBrowser EX 5 from that location. To display these files, first perform steps 
1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains from the 
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser 
EX\Library One to another location.)

The moved folder images can now be selected and displayed with 
ZoomBrowser EX 5.
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Downloading Images without Installing the 
Software
If you are running Windows Vista, Windows XP or Mac OS X (v10.3/v10.4), download images 
by simply connecting the camera to a computer, without installing the software bundled on 
the Canon Digital Camera Solution Disk.
However, please note that there are several limitations.

• It may take a few minutes, after connecting to the camera, until you can download images.
•The camera information (firmware version, etc.) may not display correctly. In this case, use the 

software from the Canon Digital Camera Solution Disk.
•Sound files attached to still images as sound memos and sound files recorded with the Sound 

Recorder function may not download depending on file size and software used.
•RAW images may not be downloadable with some software programs or operating systems. 
•Movies may not download correctly if the file size or software program is incompatible. 
• Images shot in the vertical orientation may be downloaded in the horizontal position.
•The protection setting for images protected in the camera may be lost when transferred to 

the computer. 
•There may be other problems with image downloads depending upon the operating system 

in use, the file size or the software in use.

This function cannot be used on the Windows 2000 platform. You must install 
the bundled software for downloading with this platform. 

If you use the bundled software, the following limitations do not apply.
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